
1) Elektrik Devrelerinin Ltspice ile Simülasyonu 

1.1) Giriş 

Bu bölümde, LTspice'da elektrik devrelerinin nasıl analiz edileceğini öğreneceksiniz. İncelenen 

devrelerin arkasındaki teori herhangi bir standart devre teorisi ders kitabında bulunabilir. 

Verilen devreler için bazı hesaplamaları yapmak ve bunları LTspice sonuçları ile karşılaştırmak 

gereklidir. 

1.2 ) LTspice Programının Yüklenmesi  

LTspice'ı yüklemek için Google'da "ltspice download" araması yapın (Şekil 1.1) ve ilk sonucu 

açın (Şekil 1.2). 

 

Şekil 1.1 : LTspice indirme sayfasının aranması 

 

 

Şekil 1.2: LTspice Web Sayfası 



İndirme bağlantısını görene kadar ekranı aşağı kaydırın (Şekil 1.3). İşletim sisteminize göre 

uygun sürümü indirin. Dosyayı indirdikten sonra kurun. 

 

Şekil 1.3: İndirme Linki 

LTspice ortamı Şekil 1.4'te gösterilmektedir. 

 

Şekil 1.4: LTspice Ortamı 



Help> Help Topics tıklarsanız (Şekil 1.5), LTspice yardımı ekranda görünür (Şekil 1.6). 

 

Şekil 1.5: Yardım Menüsü 

 

Şekil 1.6: LTspice Yardım Penceresi 

Yardım bölümündeki Dot Commands alanı  LTspice komutlarını öğrenmek için iyi bir 

referanstır (Şekil 1.7). 



 

Şekil 1.7: LTspice Yardım Menüsünün Dot Commands bölümü  

LTspice birçok simülasyon içeren bir "examples" klasörüne sahiptir. "Examples" klasörünü 

açmak için, aç simgesine tıklayın (Şekil 1.8) ve ardından LTspice'ı yüklediğiniz yola gidin 

(Şekil 1.9). 

 

Şekil 1.8: Aç Simgesi 

 

Şekil 1.9: Örnekler “Examples” Dosyası 



"Examples" klasörünü açın (Şekil 1.10). 

 

Şekil 1.10: Educational Dosyası 

"Educational" klasörünü açın (Şekil 1.11). Artık kullanıma hazır örnek simülasyon dosyalarına 

erişebilirsiniz. 

 

Şekil 1.11: Mevcut örnek simülasyon dosyaları 

 

 



1.3) Örnek 1: Basit Dirençli Gerilim Bölücü 

Bu örnekte, aşağıdaki basit gerilim bölücü devrenin (Şekil 1.12) davranışını [0, 100 ms] 

zaman aralığı için simüle etmek istiyoruz. 

 

Şekil 1.12: Basit Gerilim Bölücü Devre 

LTspice'ı çalıştırın (Şekil 1.13). 

 

Şekil 1.13: LTspice Ortamı 

“New Schematic” simgesine tıklayın (Şekil 1.14). Bu sizin için yeni bir şema açar (Şekil 

1.15). 



 

Şekil 1.14: “New Schematic” İkonu 

 

Şekil 1.15: Yeni şematik dosya açılır 

Direnç simgesine tıklayın (Şekil 1.16). Direnç simgesine tıkladıktan sonra fare işaretçisi bir 

dirence dönüşür. Ctrl+R tuşlarına basarsanız direnç döndürülür. Ctrl+R tuşlarına bir kez basın 

ve ardından şemaya tıklayarak bir direnç ekleyin (Şekil 1.17). 

 

Şekil 1.16: Direnç simgesi 



 

Şekil 1.17: Şemaya bir direncin eklenmesi 

Şemaya bir direnç daha ekleyin (Şekil 1.18) ve ardından klavyenizin Esc tuşuna basın. 

 

Şekil 1.18: Şemaya ikinci direncin eklenmesi 



Direnç simgesine tıklamak (Şekil 1.16), şemaya direnç eklemenin tek yolu değildir. 

Klavyenizin R tuşuna da basabilirsiniz. LTspice'in kısayol tuşları Şekil 1.19'da gösterilmektedir. 

Bu kısayolları ezberlemek iyi bir fikirdir çünkü bunlar şematik çizimi daha kolay ve hızlı 

yapmanıza yardımcı olur. 

 

Şekil 1.19: Düzenleme menüsü 

“Component” simgesine tıklayın (Şekil 1.20). 

 

Şekil 1.20: “Component” simgesi 

Component simgesine tıkladıktan sonra Select Component Symbol penceresi (Şek. 1.21) 

görüntülenir. Gerilim kaynağı bloğunu bulmak için bileşen arama kutusuna "voltage" yazın. 

Geçerli kaynak bloğu “current” aranarak da bulunabilir (Şekil 1.22). 



 

Şekil 1.21: Voltage source bloğu 

 

Şekil 1.22: Current source bloğu 



[ADC]'ye çift tıklarsanız (Şek. 1.23), içindeki bileşenler ekranda görünür (Şek. 1.24). İlk 

sayfaya dönmek için .. veya Up One Level simgesini (Şek. 1.25) kullanabilirsiniz (Şek. 1.26). 

 

Şekil 1.23: ADC bölümü 



 

Şekil 1.24: ADC bölümünün içindeki bileşenler 



 

Şekil 1.25: İlk sayfaya dönüş 



 

Şekil 1.26 Bileşen Sembolü Seçme Penceresi 

Şemaya bir voltaj kaynağı bloğu ekleyin (Şekil 1.27). 



 

Şekil 1.27: Şemaya bir voltaj kaynağının eklenmesi 

Scissor (Makas) simgesinin yardımıyla bir bileşeni silebilirsiniz (Şekil 1.28). Makas simgesine 

tıklayın (veya F5 tuşuna basın) ve ardından kaldırılması gereken bileşene tıklayın. 

 

Şekil 1.28: Cut simgesi 

“Copy” simgesinin yardımıyla bir bileşeni çoğaltabilirsiniz (Şekil 1.29). Kopyala simgesine 

tıklayın (veya F6 tuşuna basın) ve ardından kopyasını oluşturmak istediğiniz bileşene tıklayın. 

Bileşene tıkladıktan sonra, o bileşenin bir kopyası fare işaretçisine eklenir. Şematik üzerine 

tıklarsanız kopyalanan bileşen şematiğe eklenecektir. 



 

Şekil 1.29: Copy simgesi 

Bileşenleri birbirine bağlamak için Wire simgesini (Şek. 1.30) kullanın (Şek. 1.31). 

 

Şekil 1.31: Bileşenleri birbirine bağlama 

Devrenize toprak eklemek için “ground” simgesini (Şekil 1.32) kullanın (Şekil 1.33). Şemayı 

topraklama olmadan çalıştırmayı denerseniz, Şekil 1.34'te gösterilen hata mesajı görünür. 

 

Şekil 1.32: “Ground” simgesi 



 

Şekil 1.33: Şemaya toprak eklenmesi 

 

Şekil 1.34: Topraksız devre için hata mesajı 

V1 gerilim kaynağına sağ tıklayıp DC değeri[V] kutusuna 10 girin (Şekil 1.35) ve OK butonuna 

tıklayın. Şekil 1.35'teki Advanced düğmesine tıklarsanız, Şekil 1.36'da gösterilen pencere açılır 

ve daha karmaşık dalga biçimleri oluşturmanıza olanak tanır. Bu örnekte basit bir DC voltaj 

kaynağına ihtiyacımız var, dolayısıyla Şekil 1.36'daki ayarları değiştirmeye gerek yok. 



 

Şekil 1.35: Gerilim kaynağı ayarları 

 

Şekil 1.36: Gerilim kaynağı ayarları 

Şekil 1.36'daki Tamam düğmesine tıkladıktan sonra şematik, Şekil 1.37'de gösterilene dönüşür. 

Arkasında DC gerilim kaynağının değeri gösterilmektedir. 



 

Şekil 1.37: Gerilim kaynağının değeri şematikte gösterilmektedir 

R1 direncine sağ tıklayın ve Resistance [Ω] kutusuna 1k girin (Şekil 1.38). Daha sonra Tamam 

düğmesine tıklayın. Tamam düğmesine tıkladıktan sonra şematik Şekil 1.39'da gösterilene 

dönüşür. Direnç R1'in değeri arkasında gösterilir. LTspice'de kullanılabilecek öneklerin listesi 

Tablo 1.1'de gösterilmektedir. 

 

Şekil 1.38 R1 direncinin değerinin girilmesi 



 

Şekil 1.39 R1 direncinin değeri şematikte gösterilmektedir 

Tablo 1.1: LTspice'de kullanılabilecek önekler 

 

R2 direncine sağ tıklayın ve Resistance [Ω] kutusuna 1k değerini girin (Şekil 1.40). Daha sonra 

Tamam düğmesine tıklayın. Tamam düğmesine tıkladıktan sonra şematik Şekil 1.41'de 

gösterilene dönüşür. Direnç R2'nin değeri arkasında gösterilir. 



 

Şekil 1.40 R2 direncinin değerinin girilmesi 

 

Şekil 1.41: R2 direncinin değeri şematikte gösterilmektedir 

Bileşen etiketlerini üzerlerine sağ tıklayıp yeni adı girerek değiştirebilirsiniz. Örneğin, Şekil 

1.41'deki “R1” etiketine sağ tıklarsanız, Şekil 1.42'de gösterilen pencere açılır ve dirence yeni 

bir isim girmenizi sağlar. 



 

Şekil 1.42: Yeni bir adın girilmesi 

Devre düğümlerine istediğiniz adları vermek için Label Net simgesini (Şekil 1.43) 

kullanabilirsiniz. Label Net simgesine tıkladıktan sonra Şekil 1.44'te gösterilen pencere açılır 

ve istediğiniz adı girmenize izin verir. 

 

Şekil 1.43: Label Net simgesi 

 

Şekil 1.44: “Net Name” Ağ Adı penceresi 

R2 direncinin üst terminaline bağlanan düğüme “out” adını verelim. Bunun için Label Net 

ikonuna tıklayın ve Net Name penceresine “out” yazın ve OK butonuna tıklayın (Şekil 1.45). 

Tamam butonuna tıkladıktan sonra girilen ad (çıkış) fare işaretçisine eklenir ve altında küçük 

bir kare bulunur. Kareyi direnç R2'nin üst terminaline yerleştirin (Şekil 1.46) ve tıklayın. 

Tıkladıktan sonra R2'nin üst terminali “out” olarak yeniden adlandırılır (Şekil 1.47). 



 

Şekil 1.45 Net Name penceresine “out” girilir 

 

Şekil 1.46: R2'nin üst terminaline “out” adının atanması (=R1'in sağ terminali) 



 

Şekil 1.47: R2'nin üst terminali (=R1'in sağ terminali) out olarak yeniden adlandırılmıştır 

Gerilim kaynağının pozitif terminaline bağlı düğümü “in” olarak yeniden adlandırın (Şekil 

1.48). 



 

Şekil 1.48: Giriş düğümünü “in” olarak yeniden adlandırma 

Bir bileşeni aramak için “Search” simgesini kullanabilirsiniz. Bu, birçok bileşene sahip büyük 

şematiklerde çok kullanışlıdır. Ara simgesine tıkladıktan sonra (Şekil 1.49), araç çubuğunun 

sağına bir metin kutusu eklenir ve arama terimini buraya girebilirsiniz (Şekil 1.50). Örneğin, 

Şekil 1.51 ve 1.52 düğüm “out” ve direnç R2 aranır. 

 

Şekil 1.49: Search (Arama) simgesi 



 

Şekil 1.50: Görünen arama kutusu 

 

Şekil 1.51 “out” düğümü vurgulanıyor 



 

Şekil 1.52: Direnç R2 vurgulanıyor 

Text simgesine tıklayarak şematik metin ekleyebilirsiniz (Şek. 1.53). Text simgesine tıkladıktan 

sonra Şekil 1.54'te gösterilen pencere açılır ve istediğiniz metni girmenize izin verir. İstediğiniz 

metni girdikten sonra OK düğmesine tıklayın ve ardından metni eklemek için şematik üzerine 

tıklayın (Şekil 1.55). 

 

Şekil 1.53: Text (Metin) simgesi 



 

Şekil 1.54: “Comment” Yorum butonu 

 

Şekil 1.55 Şemaya bir yorumun eklenmesi 

Fare kaydırma butonu veya Şekil 1.56'da gösterilen simgeler yardımıyla 

yakınlaştırma/uzaklaştırma yapabilirsiniz. Klavyenizin boşluk tuşuna basarsanız çizilen şemayı 

gösterecek en iyi ayarlar seçilir. 



 

Şekil 1.56: “Zoom” Yakınlaştırma simgeleri 

LTspice'de yeni bir şema açtığınızda, buna varsayılan Drafn adı (n bir sayıyı gösterir) atanır. 

Dosyayı istediğiniz isimle kaydetmek istiyorsanız Dosya> Farklı Kaydet seçeneğini 

kullanmanız gerekir (Şekil 1.57). Kaydettikten sonra istediğiniz isimde dosya olarak, şematik 

dosyaya uyguladığınız değişiklikleri kaydetmek için Kaydet simgesine (Şekil 1.58) 

tıklayabilirsiniz. 

 

Şekil 1.57: “File> Save as” Dosya> Farklı Kaydet 

 

Şekil 1.58: “Save” Kaydet simgesi 

 



“Run” Çalıştır simgesi (Şekil 1.59) simülasyon türünü belirlemek ve simülasyonu çalıştırmak 

için kullanılabilir. Bu örnekte devrenin davranışını [0, 100 ms] zaman aralığında incelemek 

istiyoruz. Bunu yapmak için “Run” simgesine tıklayın, ardından “Stop time” Durdurma süresi 

kutusuna 100m girin (Şekil 1.60) ve “OK” Tamam düğmesine tıklayın. OK butonu tıklandıktan 

sonra şematik üzerine “.trans 100m” yazısı eklenecek ve LTspice ortamına siyah bir pencere 

eklenecektir (Şekil 1.61). Seçilen devre dalga formları bu siyah pencerede gösterilecektir. 

“.trans 100m” satırı LTspice'e devre gerilimlerini ve akımlarını [0, 100 ms] aralığı için 

hesaplamasını sağlar. 

 

Şekil 1.59: Run simgesi 

 

Şekil 1.60 “Edit Simulation Command” Simülasyon Komutunu Düzenle penceresi 



 

Şekil 1.61: “Trasnsient” simülasyon yapıldı 

Fare imlecinizi "out" düğümünün üzerine getirin ve tıklayın. Düğüme tıkladıktan sonra voltajı 

(toprağa göre) gösterilir (Şekil 1.62). Şekil 1.62'ye göre, "out" düğümünün voltajı 5 V'tur ve bu 

doğru değerdir. 



 

Şekil 1.62: "Out" düğümünün voltajı 

Zaman eksenine sağ tıklarsanız Şekil 1.63'te gösterilen pencere açılır. Bu pencerede 

gösterilmesini istediğiniz aralığı girebilirsiniz. Örneğin [0, 10 ms] aralığını görmek istiyorsanız 

Sol ve Sağ kutulara sırasıyla 0 ve 10m girmeniz gerekmektedir (Şekil 1.64). OK butonuna 

tıkladıktan sonra [0,10 ms] zaman aralığı gösterilir (Şekil 1.65). Dikey eksene sağ tıklarsanız 

Dikey Eksen penceresi (Şekil 1.66) görünür ve istediğiniz aralığa girmenizi sağlar. Üst 

kutucuğuna istenilen aralığın üst sınırı, Alt kutucuğuna ise istenilen aralığın alt sınırı 

girilmelidir. 

 

Şekil 1.63: Yatay Eksen “Horizontal Axis” penceresi 



 

Şekil 1.64 Yatay Eksen “Horizontal Axis” penceresine yeni değerlerin girilmesi 

 

Şekil 1.65: Çıkış penceresinde [0, 10 ms] zaman aralığı gösteriliyor 



 

Şekil 1.66: Dikey Eksen ”Vertical Axis” penceresi 

LTspice dikey eksen için en iyi aralığı otomatik olarak seçebilir. Bunu yapmak için grafiğe sağ 

tıklayın ve Y eksenini Otomatik Ayarla “Autorange Y-axis” seçeneğine tıklayın (Şekil 1.67). 

Otomatik Aralık “Autorange icon” simgesine de tıklayabilirsiniz (Şek. 1.68). 



 

Şekil 1.67: Y eksenini otomatik ayarlama “Autorange Y-axis” 

 

Şekil 1.68: Otomatik aralık “Autorange icon” simgesi 

Grafikler (izler) “graphs (traces)”, eksen, arka plan vb. için istediğiniz rengi seçebilirsiniz. Bunu 

yapmak için Araçlar> Renk Tercihleri'ne “Tools> Color Preferences“ (Şekil 1.69) tıklayın. 

Araçlar> Renk Tercihleri'ne tıkladıktan sonra Şekil 1.70'de gösterilen pencere açılır ve her öğe 

için istediğiniz rengi seçmenize izin verir. 



 

Şekil 1.69 Araçlar> Renk Tercihleri “Tools> Color Preferences” 

 

Şekil 1.70 Renk Paleti Düzenleyicisi “Color Palette Editor” 

 



V(out)'a sağ tıklarsanız (Şekil 1.71), Şekil 1.72'de gösterilen pencere görünür. Bu İzlemeyi Sil 

butonuna “Delete this Trace button” tıklarsanız grafik ekrandan kaldırılır. Varsayılan Renk 

“Default Color” açılır listesinin yardımıyla grafiğin rengini değiştirebilirsiniz (Şekil 1.73). 

 

Şekil 1.71 V(out)'a sağ tıklandığında Şekil 1.72'de gösterilen pencere açılır 

 

Şekil 1.72 İfade Düzenleyici “Expression Editor” penceresi 



 

Şekil 1.73: Mevcut renkler 

Grafiğe ızgara eklemek için grafiğe sağ tıklayıp Izgara kutusunu “Grid box“ (Şek. 1.74) 

işaretleyebilirsiniz (Şek. 1.75). 

 

Şekil 1.74 Izgara kontrol edilir 



 

Şekil 1.75 Izgaranın çıktı grafiğine eklenmesi 

Büyütme düğmesine “maximize button” tıklarsanız (Şekil 1.75), grafiğin daha büyük bir 

resmini görebilirsiniz (Şekil 1.76). Şekil 1.75'e dönmek için Aşağı Geri Yükle butonuna 

“Restore Down button “ (Şekil 1.77) tıklayabilirsiniz. 



 

Şekil 1.76 Çıkış grafiği maksimuma çıkarılmıştır 

 

Şekil 1.77 Geri yükleme “Restore down button” 

Çizilen grafiği panoya kopyalayıp başka bir yazılıma yapıştırabilirsiniz. Bunu yapmak için 

grafiğe sağ tıklayın ve Bitmap'i Panoya Kopyala “Copy bitmap to Clipboard” seçeneğine 

tıklayın (Şekil 1.78). Bu özellik, bir rapor/sunum hazırlamak istediğinizde ve devre dalga 

formlarını göstermek istediğinizde çok kullanışlıdır. 



 

Şekil 1.78 Bitmap'i Panoya kopyalama 

R1 direncinin voltajını ölçelim (“giriş” ve “çıkış” düğümü arasındaki voltaj farkı, yani Vin – 

Vout). Bunu yapmak için, fare imlecini "in" düğümün üzerine getirin ve farenin sol düğmesini 

basılı tutun; bu, "in" düğüm üzerinde kırmızı bir prob gösterir. Farenin sol düğmesini 

bırakmayın ve kırmızı probu "out" düğümüne doğru sürükleyin. Hedef düğüme ulaştığınızda 

(“node “out”), probun rengi siyah olur. Şimdi farenin sol tuşunu bırakın. Farenin sol tuşunu 

bıraktıktan sonra, “giriş” düğümü ile “çıkış” düğümü arasındaki voltaj farkı ekranda belirir 

(Şekil 1.79). 



 

Şekil 1.79: "Giriş" ve "çıkış" düğümü arasındaki voltaj farkı 

Gerilim kaynağı V1, direnç R1 ve R2'nin akımını ölçelim. Bir elemanın akımını, fare imlecini 

üzerine getirip tıklayarak ölçebilirsiniz. Gerilim kaynağı V1, direnç R1 ve R2'nin akımı Şekil 

2'de gösterilmektedir. Sırasıyla 1,80, 1,81 ve 1,82. Kaynak V1 ve direnç R1'in akımının negatif 

ve direnç R2'nin akımının pozitif olduğunu unutmayın. Fare imlecinizi bir elemanın üzerine 

getirip tıkladığınızda, LTspice bileşenin pozitif terminaline giren akımı ölçer. Pozitif terminale 

giren akımın pozitif olduğu varsayılır. Gerilim kaynağının pozitif terminali + etiketli 

terminaldir. Bir diyotun pozitif terminali anot terminalidir. Dirençlerin, indüktörlerin ve 

kapasitörlerin pozitif terminalinin özel bir sembolü yoktur. Ancak pozitif terminali 

belirlemenize yardımcı olacak bazı kurallar vardır. Şemaya herhangi bir dönüş olmadan bir 

direnç (veya indüktör veya kapasitör) eklerseniz, pozitif terminal üstteki terminaldir (Şekil 

1.83). Bileşeni yerleştirmeden önce Ctrl+R tuşlarına bir kez basarsanız pozitif terminal sağdaki 

terminaldir. Ctrl+R'den sonra Ctrl+E'ye basarsanız pozitif terminal sola gelir (Şekil 1.83). 

 

Şekil 1.80: Gerilim kaynağından çekilen akım 



 

Şekil 1.81 R1 direncinden geçen akım 

 

Şekil 1.82 R2 direncinden geçen akım 

 

Şekil 1.83 (a) + ve − terminallerinin varsayılan konumu (b) Ctrl+R'ye bir kez basılmıştır (c) 

Ctrl+R'ye bir kez basılmıştır ve ardından Ctrl+E'ye basılmıştır. 

Devre bileşenlerinin pozitif terminalleri Şekil 1.84'te gösterilmektedir. Direnç R1, Ctrl+R 

tuşlarına basılarak döndürülür, böylece pozitif terminal sağdaki terminal olur. Devre akımı V1 

ve R1'in pozitif terminalinden çıktığı için bu bileşenlerin akımı negatiftir. Devre akımı R2 

direncinin pozitif terminaline girer, dolayısıyla R2 direncinin akımı pozitif olur. 



 

Şekil 1.84 Bileşenlerin pozitif terminalleri 

Şekil 1.81'de I(R1)'e tıklarsanız ve I(R1)'i –I(R1) olarak değiştirirseniz (Şekil 1.85), grafik 

pozitif olur (Şekil 1.86). 

 

Şekil 1.85 –I(R1) metin kutusuna girilir 

 

Şekil 1.86 –I(R1) grafiği 

Alt tuşunu basılı tutarak bileşenin üzerine tıklayarak bileşenin gücünü görebilirsiniz. Örneğin, 

R2 direncinin gücü Şekil 1.87'de gösterilmektedir. Direnç güç tükettiği için güç pozitiftir. Alt 

tuşunu basılı tutarsanız ve V1 voltaj kaynağına tıklarsanız Şekil 1.88'de gösterilen grafiği 

göreceksiniz. Şekil 1.88'de gösterilen grafik, güç kaynağı devreye güç sağladığı için negatiftir. 



 

Şekil 1.87 V(out)*I(R2) grafiği 

 

Şekil 1.88 V(in)*I(V1) grafiği 

Simülasyon parametrelerini Simulate> Edit Simulation Cmd tıklatarak düzenleyebilirsiniz 

(Şekil 1.89). Edit Simulation Cmd tıklattıktan sonra, Şekil 1.90'da gösterilen pencere açılır ve 

istenen değişiklikleri simülasyon parametrelerine uygulamanıza izin verir. “Time to start saving 

data” kutusuna 80m girin (Şekil 1.91) ve “OK” butonuna tıklayın. “OK” butonuna tıkladıktan 

sonra şematik Şekil 1.92'de gösterilene dönüşür. Simülasyonu çalıştırırsanız Şekil 1.93'te 

gösterilen sonuç görünür. Şekil 1.93'te gösterilen grafiğin 0 ve 20 ms noktaları, devrenin 

sırasıyla t = 80 ms ve t = 100 ms'deki davranışını göstermektedir. Devrenin [0, 80 ms] aralığı 

için davranışı bu grafikte gösterilmemiştir. 



 

Şekil 1.89 “Simulate> Edit Simulation Cmd” 

 

Şekil 1.90 Edit Simulation Command penceresi 



 

Şekil 1.91 İstenilen simülasyon ayarlarını “Edit Simulation Command” penceresine girme 

 

Şekil 1.92 Simülasyon komutu şematik olarak eklenmiştir 



 

Şekil 1.93 [80 ms, 100 ms] aralığı için simülasyon sonucu 


